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TACTIC End User

Introduction to TACTIC
What is TACTIC?

TACTIC is an extensible, web-based data and file management system. TACTIC centralizes the following aspects
of digital project workflow:

¢ Production data management

e Scheduling

¢ File (Asset) Management

¢« Communication

* Reporting

¢ and more

How does TACTIC work?

TACTIC manages two aspects of Digital Content Management: Project data and Files. TACTIC maintains both of
these componentsin one unified source.

Project Data

Project data is stored
in the Database

Project Data is the information and lists that are traditionally tracked in
spreadsheets. TACTIC has the ability to list al files you manage along with
task assignments, status, and scheduling data, which can be viewed in simple
table formats or complex custom reports. TACTIC eliminates lost email
threads, missing documents, and the need to update complex spreadsheets.
The "database” is the base location for al data. i.e. notes, reports, schedules
etc. What a database providesis a central location for this information.

Content/
Files

FilesstoredintheFile
System

Content refers to the actual files. When managing assets/files the directory
and file naming, along with proper version control is what makes TACTIC
unique. Files in TACTIC are managed externally in afile system. i.e. hard
drive. Thefile server typically hasaroot ‘assets directory. From thislocation,
TACTIC handles the filenames and directories for that file system.

What can | do with TACTIC?

End-Users have various roles within a project or organization. The TACTIC interface can be moulded to provide
each group (department) with the ideal interface.

The TACTIC security architecture is a rules-based system where each End-User is provided with alogin. The End-
User is assigned to groups determined by the project leader or administrator. These rules determine what the End-
User has accessto within TACTIC.

Communication between groups and departments can be tracked in real-time by using the TACTIC Notes
functionality. This method eliminates lost email threads and misplaced documents.

TACTIC can manage limitless amount of tasks, the status of those tasks and the location of all files being managed.
TACTIC givesthe End-User an accurate real-time understanding of how a project is progressing.

The table below illustrates how various End-Users may interact with TACTIC in a single organization.
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Content Creator The Content Creator often requires a view of all tasks assigned. The user can update a

status, check in and check out files, log work hours and communicate with Supervisors
using the Notes widget.

Super visor/Manager The Manager/Supervisor is often required to schedule tasks, manage content and

resources. The project schedule can be adjusted in the User Schedule or Project Tasks
view. The TACTIC interface provides high level planning, communication and reporting
tools. The Supervisor often has accessto all views which provides the ahility to plan and
adjust the overall needs of a project quickly and easily.

Client Clients often need to review project material (documents, videos, images etc) and

managing this continuous feed of content is often a hurdle. TACTIC's built in web
technology allows Clientsto deliver files and provide real-time feedback without FTP or
Email. TACTIC can provide Clients with only the specific views and permissions needed
for each project.

Executive Executives require a high level view of the project. This often involves building views

or "reports" that correlate datafrom all aspects of the project. TACTIC isableto provide
cost reporting, completion, efficiency and location of bottlenecks.

What can | do in TACTIC?

TACTIC isatransaction system allowing users to search, interact, update and report on project data and files. These
interactions are carried out using afew main operations:

Sear ch - Search query results are often displayed in alist where you can interact with your project data.

Insert - Additions or "Insert" new data is often done at the start of a new project. This is done through various
interface tools like forms, multi inserts, CSV import and more.

Update - Updating existing data is sometimes required. For example; updating a status, adding keywords, or
changing an assigned user. Specific views and tools also allow for selecting multiple itemsto edit at one time.

Check-in - Part of TACTIC's power isthe ability to check in and manage your files/assets. When you do a check-
in, TACTIC versions and names the directories and filesin your file server. Files remain organized and will never
become lost.

Check-out - When you need to work on some files that are already checked into TACTIC, you can check them
out. This process either points you to the where the files are located, or downloads them to your computer.

Undo/Redo - Every action carried out within TACTIC can be undone. If a mistake has been made, simply undo
the transaction.

How do | access the TACTIC interface?

TACTICisdelivered asaweb site. Thisweb based solutionisextremely powerful becauseit allowsfor full interaction
with TACTIC and aso direct integration with supported software packages.

Accessing TACTIC isas simple as visiting your server's address (URL) in your web browser. For example:

http://yourcompany.southpawtech.com

Lets Get Started!

The following End-User documentation provides general usage of the TACTIC feature set. Additional information,
tutorials, forums and documentation is available on our TACTIC Community site:
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http://community.southpawtech.com
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TACTIC Start up

Setting Up Your Web Browser

Web Browser
To accessthe TACTIC interface, a supported version aweb browser is required.

To connect to the TACTIC server, type a URL in your web browser similar to the example below (the |P address
will vary depending on the network setup of your organization). An example is shown below:

http://192.168.14.198/

When you are connected to the server, you are presented with the TACTIC login screen:

TACTIC

i Note
If you cannot see this TACTIC login, please contact your TACTIC Administrator.
Java Support

For certain transactions to occur between TACTIC and the client computer, Javawill need to be installed. Currently
TACTIC supports: Java JRE 1.6.0+

To download the Java Runtime application, please visit:

http://www.java.com



http://www.java.com
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Interface Map

When you log into TACTIC from your browser, you will see awindow similar to the following image. This section

describes some of the important parts of this window.

2a —

2b—s

2c —a

1 - Header

la

Project
Homepage Link

ategory Asset Cod Title Description Keywords Chackin History Tasks Task Pipelne

The project bar shows the TACTIC logo and release. This link will also direct you back to
the project selection page.

1b | Project This area shows the name of the project and thumbnail.
Thumbnail
1c |Project Selection|A drop down list to switch between projects.

Menu

1d

Main Action
Menu

Main TACTIC Actions menu.

le|User Menu Allows for editing of basic user settings

1f [Main Help Link |Loadsthe Builtin TACTIC Help (documentation, links etc)

2 - Sidebar

2a|Project Project Views contains links to different views with information about the project as well as
Views workflow.

2b|My Views |My viewsisacollection of views that are custom created by the login user for personal use.

2c

My Admin |My Admin displays the Tactic system, as well as the project and adminstration schema. Access

to this part of the sidebar is generally reserved for admin level users.

3a
3b

e

3d
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3 - Main View Panel

3a|Tabs Tactic supports loading multiple tabs, similar to how web browsers handle tabs. Views can
be loaded into tabs either automatically or through right-clicking on alink.

3b|Simple Search | In some views, asimple search will be included. The Simple Search option provides a quick
and easy way to search specifically within the current view in use.

3c |View Toolbar In some views, there will be tools which are specific to the view. For example, the "Table"
view provides an array of tools for interaction with that table.

3d|Main Panel The Main Panel is where the actual results of the view are displayed. This can be atable,

tile tayout, dashboard etc.
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TACTIC Gear Menus

Top Gear Menu

gl
Add
Edit
Tools
Help

v v v

Add

Add New sType

ietup Create Schema

B © & Q@

Add New Asset
Add New Asset Category
Add New Budget

Add New Burndown

Add New Expenses

u u u
asset_category budget pburndown
u u

asset EXpENsSes

Add New sType ‘Add anew sType to the schema.
Add New <...existing sType from schema...>

Open anew tab and pop-up awindow to insert anew item
of the existing sType from the schema.

Edit

Undo Last Server Transaction
Redo Last Server Transaction

Show Server Transaction Log

Undo Last Server Transaction Undo the last transaction.

Redo Last Server Transaction Redo the last transaction.

Show Server Transaction Log Display the Transaction Log in a pop-up. The log holds
al the transactions since the creation of the project.

Tools

Web Client Output Log
TACTIC Script Editor
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Web Client Output Log Load the Web Client Output Log. This log details

TACTIC output aswell output from statementsin scripts.

TACTIC Script Editor ‘ Load the TACTIC Script Editor pop-up.
Help
5l
s PV »
Edit »
Tools »

Documentation
TACTIC Support Community

Documentation ‘ Open anew page to TACTIC's Documentation.

TACTIC Support Community ‘ Open anew page to TACTIC's Support Site.

Gear Menu for the View

[‘} @+ H :ii .UJ‘,] 11 items found

[ Preview Category /| Edit ¥ llesc
B i »
video 2 3 tock

Clipboard * botac

o = View F fucle

Print » [xplo:

ey Chart »
ﬁ video a tock
_ R botag
[ Tasks L
Notes ¥ |arch

Check-ins »
3d e Pipelines » |DC:

et

— warel
seftin

Edit
Retire Selected tems
File L4 Delete Selected tems
Clipboard »
View » Undo Last Server Transaction
Print » Redo Last Server Transaction
Chart [ 3
Show Server Transaction Log
Tasks [ 3
Notes [ 3
Check-ins [ 3
Pipelines »
Retire Selected |tems Retire the selected items. Retired items are hidden from
the view, but not removed from the database.
Delete Selected Items Delete the selected items. Deleted items are removed
from the database and are no longer available.
Undo Last Server Transaction Undo the last transaction
Redo Last Server Transaction Redo the last transaction
Show Server Transaction Log Load the TACTIC Transaction Log. The Transaction Log
holds all the transactions since creation of project.
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Add Tasksto Selected ‘Add tasks to the selected items.
Add Tasksto Matched ‘Add tasks to the matched items.
File
Edit » |
Export Al ...
Clipboard L4 Export Selected ..
View L4 Export Matched ...
Print L4 Export Displayed ...
Chart »
Import CSV ...
Tasks »
Notes »
Check-ins L4
Pipelines »
Export All ... Export al of theitem in the view.

Export Selected ...

Export al of the selected itemsin the view.

Export Matched ...

Export al of the Matched itemsin the view.

Export Displayed ...

Export al of the displayed items in the view.

Import CSV ... Import aCSV file.
Clipboard
Edit »
File »
Copy Selected
Wigw * Add Selected
Print L4 Paste Clipboard
Chart L4 Show Clipboard Contents
Tasks »
Notes »
Check-ins »
Pipelines »
Copy Selected Copy theitem that is selected in the view (indicated with
a check mark) to the clipboard.
Add Selected Addtheitemthat isselected in theview to thelist of items
already on the clipboard.
Paste Clipboard Paste the items from the clipboard to the current view.

Show Clipboard Contents

View

Edit »
File »
Clipboard »
View

Print »
Chart »
Tasks »
Notes »
Check-ins »
Pipelines »

Column Manager
Create New Column

Edit Current View (sz=et_tracking)

Sawve Current View
(5zzet_tracking)
Save a New View

Display the contents of the clipboard in apop-up window.

10
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Column Manager Pop-open the Column Manager.
Create New Column Pop-open the Create New Column Window
Edit Current View Edit the current view.
Save Current View Save over the existing view with the current
configuration.
Save a New View Save the current view as anew view in the sidebar.
Print
Edit [ 3
File [ 3
Clipboard »
View [ 3
Print Selected
Chart L4 Print Displayed
- Print Matched
Tasks [ 3
Notes [ 3
Check-ins [ 3
Pipelines »
Print Selected Print all the selected itemsin the view.
Print Displayed Print all the displayed items in the view.
Print Matched Print all the matched items from the search criteria
Chart
Edit [ 3
File [ 3
Clipboard »
View [ 3
Print [ 3
Chart tems
Chart Selected
Tasks [ 3
Notes [ 3
Check-ins [ 3
Pipelines »
Chart Items ‘ Create a chart of displayed view.
Chart Selected ‘ Create a chart of the selected items.
Tasks
Edit [ 3
File [ 3
Clipboard »
View [ 3
Print [ 3
Chart [ 3
Show Tasks
Notes [ 3
Check-ins * Add Tasks to Selected
Pipelines * Add Tasks to Matched
Show Tasks Add the Task Edit column to the view.

11
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Add Tasksto Selected

For the items that are currently selected in the view, add
tasks to them.

Add Tasksto Matched

Notes

Edit

File
Clipboard
View
Print
Chart

Tasks

Check-ins

v v v wTwTw

»

Check-ins »
Pipelines »

Show Notes

Show Notes

Edit

File
Clipboard
View
Print
Chart

Tasks

Notes

Pipelines »

v v v wTwTw

»
»

Show Check-in History
Show General Check-in Tool

Show Check-in History

‘ For all theitemsreturned by the search, add tasksto them.

Add the Notes column to the view.

‘Add the Checkin History column to the view.

Show General Check-in Tool

Pipelines

Edit

File
Clipboard
View
Print
Chart

Tasks
Notes

Check-ins

v v v wTwTw

-

-

Show Pipeline Code
Edit Pipelines

Show Pipeline Code

‘ Add the General Check-in Tool as a column to the view.

‘ Add the Pipeline Code column to the view.

Edit Pipelines

‘ Open the Workflow Editor in a new tab.

12
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Sidebar

Project Views Asset Tracking

| StartHere

Keywords: |

== My Dashboard
== Project Dashboard ,} © E
[#] Report Dashboard

[ Preview Cal
Asset Tracking

» " Schedule n g
» .l Finance L =

¥ [, Reports
» @ Review
¥ | 5 Library

» [;] Manage Lists
L) Development

o O
- No items - o

| Adminviews |
 Project Setup 3d

» My Admin -

» Project Admin

» Site Admin

» Schema Views -

Description

The TACTIC sidebar is the main menu system for navigating through the views in the TACTIC Project. The access

rules applied to a specific account determine the contents of the sidebar as well as which views are displayed when
auser isloggedin.

Theitemsin the sidebar provide linksto existing views within a project. These views are built by your organization's
production manager based on a selection of columns (properties), layouts (order and column width) and a search. If
asearch view is available, it provides a dynamic report based on the definition of the search.

The sidebar is divided into three different categories, "Project Views', "My Views' and "Admin Views".

Project Views and My Views

— The Project Views provides away to save project wide views that everyone acrossthe entire
Project Views . . .
o project would want to see. It also has a manageable list of custom user views.
| StartHere
== My Dashboard

The Project Views can be defined by the person in the role of the project manager. Views

a2 Project Dashiboard can also be hidden from specific user groups.

[#] Report Dashboard

Asset Tracking My View contains a list of links to views that were created by the login user themselves.
» " Schedule

» B3 Fnaace These usually are created by the user to cater to their own personal work flow.
¥ [, Reports
» @ Review
¥ | 5 Library

» [;] Manage Lists
L) Development

- No items -

13
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Admin Views

Admin Viewsdisplaysthe project schemaand the TACTIC system and administration schemas. Accesstothe Admin
Views section of the sidebar is generally reserved for admin level users.

My Admin - My Admin holds views that will allow the users to manage My Views and My Preferences.

* My Admin
a5 Manage My Views
-Lé My Preference

Manage My Views Edits the views saved in the "My Views' section.
My Preference Preferencesinclude: Debug, Web Client Logging Level, Color Palette, Language,
Quick Text for Note Sheet Thumbnail Size

Customizing the Sidebar

Y ou can add any view to the sidebar very easily. If you have aview open in atab, you can simply right click on the
tab and select “Add to Side Bar”. Thiswill add the link to the sidebar under the Project Views. Thiswill alow you
to customi ze the sidebar and let you quickly open your important views which you use regularly.

Reload Tab

New Tab
Tear Off

Copy To Main Tab

Close Tab

Now, “My Dashboard” will be alink in the sidebar which takes you to this view. You can just as easily remove this
link from the sidebar by right clicking on the link and selecting “ Remove Link”.

Project Views ( My Dashboard

Admin views Open Link In New Tab

Open Link In New Window

Remove Link

Edit Side Bar

14
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Preferences

How to Change Your Password

1. Loginandgotothetop right hand corner of the screen. The name of the current user loggedinto TACTIC session
isdisplayed here. Click on the button labelled "My Account". From the context menu, select "Edit My Account".

2. Typeinthe new password and re-confirm it in the following field.

My Account =]

login_bobby_web_icon_w001.jpg

Browse
bobby
—_——
L
|

L 1
re-enter

Firstname Bobby
Lastname Supervisor
Email dan@southpawtech.com

Modify any other account information that needs to updated and hit Save.

15
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Interface Usage

Insert

Introduction
TACTIC provides many waysto insert new items. For the beginner, insertion of anew item can done through aform

that guides you through each input field. For the more advanced used, insertion of an item can be done directly inline
in the view. The various methods to insert items are described bel ow.

The Insert Menu Options
The insert button is on the tool shelf. It isthe button with the green circle, with awhite plus sign inscribed. Clicking

on the button bring up aform to guide you through each input field. The down arrow triangle next to the button allow
you to do the insert in different ways.

( Shot List ] ok

.;. Add New kem (in Page)
Add New kem (Form)
Add Multiple tems.

Each option of the Insert menu is described in detail below.

Add New Item (in Page)

This insert menu option adds a new row directly into the page that you are viewing. The advanced user would be
more comfortable using this method.

( Shot List ] ok

Add New kem (Form)
Add Multiple tems.

Oncein thisinsert mode, refer to the column headers as a guideline as to the type of data to enter into the input field.

| shot List | |T|

[J} @~ = i _U;av] ‘ 1 item found Showing: «/[1-1  [=] » oy

S01_001 S01 The first IP shot
- Sequence

All input fields are optional. If no datais entered into an input field where one would be required, such as Code, an
appropriate default will be automatically generated.

16
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note: Hitting the green plus sign will insert multiple rows into the view. This facilitates inputing data for multiple
new items quickly.

Shot List £d |T|
[% @~ HF i _Ung ‘ 1 item found Showing: « [ 1-1 =l ] ‘ [‘Q
. Preview  Code  Sequencecode Description Shotstatus Pipeline code Task edit

W

=

HEwW|

S01_001  sS01 The first IP shot b
L Sequence

Add New Item (Form)

This menu option open a window which guides you through the data to enter for each input field. This method of
inserting an item is a good place to start for the beginner.

Once the insertion form pops up, the description on the left hand side can be used as a guide as to the type of data
to enter into the input field.

Add Single ltem (=}

Code (optional)

Sequence code

Description

Shot status

Pipeline code — Default — :
| Insert ] | Cancel ]

All input fields are optional. If no datais entered into an input field where one would be required, such as Code, an
appropriate default will be automatically generated.

Add Multiple ltems

This menu option opens Multi-Insert the pop window.

17
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The Multi-Insert pop-up window, allows you to add the same item multiple times.

(Browse J

e —
Sequence code |- Select- [ v |
Description ‘

sotsaus
Pipeline code |~ Deraut [+

[_insert ] [_Cancel |

The most important value that must be entered is one for the Multiplier field.

The number entered into the Multiplier box determines how many items that will be created.
Sequence code will determine which sequence the items will be placed under.

The Code value will be incremented by the value that is entered into the Multiplier.

*Note - The value for Code must start with a letter.

All the other values are optional.

18
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Edit
Introduction

The following describes how to edit the datain various views of TACTIC.
Editing Using a Form

To edit arow of data, right click anywhere on the row and select "Edit" from the context menu.

Save All Changes

A form pop-up to edit the data will appear. The description on the |eft side indicates what data to enter into the input
fields.

Cose (oponal o

Sequence code S04 =

Description The first Sequence

snotsats
Pipelinecode  snot <]

[__save J [ Cancel |

Editing Inline
Clicking on afield within the row allows editability only if edit mode for that column is enabled.
Below is afew examples of edit modes for the various widgets:

The edit mode for the Text Widget is most common. This widget allows keyboard entries into editable fields.

19
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The edit mode for the Selection Widget is displayed below. The widget restricts your input choices to the options
in the drop down selection menu.

The edit mode for the Calendar Widget is displayed below. The Caendar widget pops-up a monthly calendar for
convenient date selection.

) October, 2011 » K
Su Mo Tu We Th Fr Sa
25 26 29
2 3
g 10
16 17
23 24
a0 31

Multi-Edit

To modify the more than row so that they all have the same data, first check mark the rows to be edited.

Shot List i

Left click on acell in the column to be edited. The row will go into edit mode.

20
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2 items found Showing:

-I.- o I

Once the text is entered, click off the cell. All cells selected will have the same data.

Delete and Retire

Introduction

TACTIC provides many waysto delete and retireitems directly from the view. Retiringis TACTIC'sway of marking
an item so that it does not appear in any searches, but allows the user to bring it back if necessary. The methods to
delete and retire an item are described below.

Deleting from the Context Menu

To delete an item from the view, first put a check mark in the box next to the item you want deleted. Then, right
click anywhere on the row to bring up the context menu. Selecting the "Delete” option will delete the object from
the view and from the database.

Deleting from the Gear Menu

Alternatively, the gear menu can be used to delete an item from aview.

21
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1. Put acheck mark in the box next to theitem.
2. Inthetool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Delete" option will delete the object from the view and from the database.

snowng: (12 =]

Note

If an item is deleted by mistake, to undo this action, go to the top gear menu, select Edit -> Undo Last
Server Transaction.

Retiring from the Context Menu

To mark an item as "Retired", first put a check mark in the box next to the item. Then, right click anywhere on the
row to bring up the context menu. Selecting the "Retire" option will mark the object as retired and filter it out from
the view.

note: Items will still exist and can be brought back. The next section will shows how to view items that have been
marked as "Retired".

Retiring from the Gear Menu

Toretire an item from the view using the gear menu:

22
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1. Put acheck mark in the box next to theitem.
2. Inthetool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Retire" option will mark the object asretired and filter it out from the view

: Note

Theitem will till exist and can be brought back. The next section will shows how to view itemsthat have
been marked as "Retired".

[‘?g @~ HF i .;J;:'J ‘ 2items found | Showing: « [1-2 =] »
L) Edit
File
Clipboard

Retire Selected tems
Delef cted tems

Undo Last Server Transaction
Redo Last Server Transaction
Show Server Transaction Log

Showing Retired Items

When anitemis "retired", it has simply been marked as "retired” in the database. The item still existsin the database
and can be brought back. To show items that have been retired in a view, go the any column header and right click.
Thiswill bring up a context menu. Select " Show Retired".

Shot List ||T|

[‘?ﬂ @~ H :id -;,;’.J ‘ 2items found = Showil

[ olumn

Order By (Ascending)
Order By (Descending)
Group By

Edit Column Defintion

Remove Column

Table Columns & Contents

Column Manager
Create New Column

Remove Grouping

Hide Retired

Note
Theitems marked as "retired" appear highlighted in red.

Cl

g 502_001 501

23
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Creating and Editing Views

Shot List || +|
. Sequence | |w||—Select—
Job Code: is — Select —
=] =] ‘ Code:
Assigned:  |&  [v | —Select— [=]

[ 2 O-H :id MJ’.] ‘ 164 items found Showing: «[1-100 [=] » ‘ e ‘ a s
. Preview  Job  Sequence  Shot  Frame couni Source sta Pipeline cod History

“ TR TR_001 2001 279 1 dilshot b)) b
-

‘ TR TR_003 2301 277 1660 difshot b
L

- TR TR_003 24DI 54 1937 dilshot b
L

- T TM_001 TM_001_001 101 1 difshot b
L

@ ™ TM_002 TM_002_001 764 102 dilshot b
L

BI1 T TM_002 TM_002_002 1189 266 difshot b
- d

i

TACTIC provides the following configuration display options when creating or editing a view:
¢ Which columns are part of the view

¢ The order of the columns

The width of each column

The Grouping of theitems
* The Search which has been applied to the view

In TACTIC, there are 2 main distinctions between the types of views Project Views and My Views. These are
presented in 2 sections within the main sidebar.

« Project Views - Project views are presented to al users in the production and/or can be hidden based on group
accessrules. Project viewsareal so generally only created by the project manager and the ability to save and modify
them can also be blocked with group accessrules.

*« My Views- My viewsareviews saved per user. It allowsfor saving of personal views outside of the project views.
These will only be available to the user who created them.

24
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Adding Columns

To add a column, right-click on any column header in the view.

ICD|LI|’II'I

+ Custom Widgets

d this week

[Jaee

Dclient discussion {dlient_discussion)

PR d_this_week)

Dclient status (client_status)
[]code (code)

l:‘ Discussicn {discussion)

|:| File Usage mb {file_usage_mb)
Frame count (frame_count)

l:‘ Frames as ti
[]40b code (iob_code)

[ [Late tasts (ste_tasis)

|:| Motes this week {notes_this_week)
Fipeline code (pipeline_code)

l:‘ Play shot in source {play_shot_in_source)
Preview [preview)

{frames_as_ti

Sequence code (sequence_code)

|:| Snapshots this week (snapshots_this_week)

l:‘ Status changes this week (status_changes_t ...

|:| Task schedule actual {task_schedule_actual)
[ |Total cost ftotal_cost)

[ | Total hours ftotal_hours)
|:| Total Snapshots {total_snapshots)

Add Shot oo
Coonen) 2 e e TR
% O~ H i1 & |1B4itemsfound Showing: «[1-100 [ ] w [ | | 4

TR_001 2001 279
L

TR_003 2301 277
L

TR_003 2401 5e
L

TM_001 TM_001_001  |101
L

TM_002 TM_00Z_001 |78
L

TM_002 TM_00Z_002  |1189 566
L

TM_003 TM_003_001  |838 2055
L

TM_003 TM_003_002 |84 2891
L

TM_003 TM_003_003 | 1180 3537
L

TM_003 TM_003_004 |29 a7
L

TM_003 TM_003_005  |430 2748
L

TM_004 TM_004_001  |551 5178
L

TM_004 TM_004_002  |388 5727
L

Select the Column Manager

In the column manager, selecting columns will add them to them current view. The sections in the column manager

are as follows:

e Custom Widgets - These are the custom widgets which have been defined for the current type. These represent
both changes to information (i.e.. switching a code) as well as tools which represent certain actions for that type

(i.e.. abutton which loads the asset into an application)

e Common Widgets - These widgets are similar to the ones above but, are common to all typesin TACTIC. They

are tools which are generally universal.

¢ Raw Database Columns - These are the raw data (property) columns which exist for the type. Generally, each
is represented by a Property Column but, this allows adding of the datain its raw format. For example, atask has
'start_date' and 'end_date' database columns but, there may be a 'schedule’ column which displays the start_date

and end_date together in a calendar widget.

i Note

Certain widgets require Java to be started up so, it can take a few seconds for the selected column to

- Common Widgets
[ | eheckin wdg (checkin_wdg)
DCDmp|EﬁDI1 {completion)
l:‘ Discussicn {discussion)
l:‘ Expand {expand)
l:‘ Explorer {explorer)
l:‘ {general_chedkin)
l:‘ General publish {general_publish)
l:‘ Group completion (group_completion)
History (history)
[ | Motes sheet (notes_shest)

actually appear in the view. When finished, click the close button.
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Removing Columns

To remove a column from the current view, left click in the column header for the column to be removed and choose
Remove Column. Columns can also be removed through desel ecting them in the column manager.

artoo1 characters
characters001 characters Lizard ct
8 characters002 characters DJ char:
H
Q characters003 characters Boy chal
&4
ﬁ characters004 Hide Retired characters Girl char
‘.:._' |

Ordering Columns
To re-order columns, click and drag a column in the header to the desired location in the view. Asthe column header

isdragged to the left or the right, an orange bar will appear between the columns indi cating where the column appear
if the mouse button is released.

Resize Columns

To resize acolumn width, hover the pointer over the divider between the column headers and the mouse pointer will
change to awidth adjuster.

Left click and drag the width adjuster to change the width of the column.

2001 279 1

26



TACTIC End User

Grouping

Some columnsin TACTIC contain categorical data. Some examplesinclude 'status), 'parent’, ‘assigned user' columns.
These columns can be grouped.

For example, grouping by the Assigned User column displays the items in groups by each user.

2 B -3{, awll1-20 [ [w C&’ 1 a

vehicles002 colour |approved |brad 3 3 3 Dec 22 Bl Dec 26

- 1 colour |approved |brad b 3 3 Jan 28 M Jan 31
02 | colour brad b 3 b Dec 20 W Dec 26

[ |vehicles001 delivery |Review | jimmy » b » Feb 011Feb 01
| |vehicles002 delivery |assigned |jimmy (3 3 ¥ Feb018Feb 01
) 1 delivery Igned | [immy 9 [ b Mar 05 iMar 05
o delivery g jimmy b b 3 Mar 05 iMar 05
o delivery limmy b b b Mar 05 IMar 05
- delivery | assigned | jimmy b 3 3 Mar 05 IMar 05
- 1 | delivery g jimmy b b b Jan 221Jan 22
o 115002 | delivery | assi limmy b 3 b Jan 221Jan 22
- a1 delivery | assigned |jimmy [ 3 [ Mar 07 IMar 07
) |emo03 delivery |assigned |jimmy b (3 b Jan 221Jan 22
() |vehicles001 colour |approved |mark (% 3 2 Dec 17 M Dec 20
) |vehicles001 rough |approved |mark 3 3 2 Dec 13 M Dec 15
) vehicles002 rough | approved | mark L 3 8 Dec21M@Dec22
o 1 rough |app d |mark ¥ 3 2 Jan 24 1Jan 24

To apply grouping to aview, left click on the column header to be grouped and choose Group By

- wvehicles001 rough approved mark | Order By (Ascending) b b
Order By (Descending)
- vehicles001 colour approved mark _ » »
- wvehicles001 delivery Review jimmy = b b
- vehicles002 rough approved mark » »
Column
vehicles002 colour approved prad b b
o | Tabe Columns & Contents |
[ |vehicles002 delivery assigned jimmy| Column Manager [ [
Create New Column
characters001 rough approved mark b b
(]
[} |characters001 colour approved brad | show Retired [ [
Hide Retired
[ |characters001 delivery assigned jimmy I l 2 3
| characters002 rough approved mark | | » » »
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Search

The Search Tool isused as afilter to only display items which match a certain criteria. This allows the resultsin the
view to be narrowed down. When a view is saved, the search criteriais saved with the view which causes the view
to become alive report as each time the view is loaded the search filter will be applied to the live data.

For example, if a search filter is created which shows only items which have a child task with the status "Review",
the view will provide areport of all items which need to be reviewed. When the status of these tasks are changed,
the items will be filtered out and no longer appear in the view.

(_search ]

[] [Proiectcoge [ ][is [ ||tsPrRoJECT:

[v] [ status B2 [ ||Review

Feb 01 MFeb 01

Mar 05 1Mar 05

Jan 221Jan 22

Dec 17 MDec 20

Jan 241Jan 24

Jan 28 1.Jan 28
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Saving the View

After the display of the view have been configured, to save the view, go to the gear menu under View. The options
are described below.

e Save Current View - Saves over the existing view. (Available only to users with access to save project views.
Otherwise, it will save anew My View)

* Save AsNew "My View" - Saves the view to the user's personal My Views. (Available only to users who can
create views)

« Save AsNew " Project View" - Save anew project view which will be available to all users. (Available only to
users with the appropriate access.)

¢ Edit Current View - Opens up a pop-up window to edit the table and the columns.
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Searching

Search Interface

[ 2 O~ =3 it .{,.'?,] 44itemsfound  Showing: 4 [1-48  [w]w | | Q| @ 2filter/s ]
Search Criteria
| Description Status Mile
[J DesignTaskforasset002 |Pending | Delivery i Search Maich sl [] on the following &
L) Plan scope of project Assignment - Keyword Search
2 _ Delivery M - -
[] Meetings with client _ ] o
[J Consultant onsite [waitng | - Filter
g @] [Projectcode  [+] [is [=] [isPrRosECTy
o [ [ [
m] o - -
@ [Status [=] [snot  [=][approved
L) Design Planning i i
o v Parent
= _ Delivery M ¥ Children
[ (SEREI o< iivery 1
= R oo (Csearen ) (Cciear ]
[]  Getmaterials :Pentlng o A
o [ESSEEI ocivery i Project mark  2011-08-08 00:00:00 08108/11 00:00 0

The TACTIC Search Box is used to build filters to refine the results in the view. A variety of search filters can be
constructed, ranging from simple column searchesto large complex compound searches. The creation of searchfilters
closely resembles that of creating mail filtersin a mail application. Each search filter plays arole in the outcome of
the final results. The Search Box is flexible enough to handle any kind of search.

Keyword Search

Open the Search Criteria by clicking the ‘ © 1 button on the tool shelf.

[’_-3-' @~ EH a: .‘,-",J 3itemsfound = Showing: «w/[1-3  [w]w [ | Q l.:. @
| Preview c v Search Criteria

car, chase, fast, [ :
2 g EEEE l [ EE | Match al : on the followin 1
race, map atcha 9 &

« Keyword Search

car, warehouse, [¥] |car o
— dark, headlights,
- exterior, engine ¥ Custom
v Filter
b Parent

car, warehouse,
interior, dark, ¢+ Children
headlights, engine

(_Clear ]

The keyword search section allows for creation of a search filter to search on the words found in the column named
keywor ds. These keywords must be manually inputted and updated.
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Filter

Search Criteria

_Search_| [ Clear | WMatch all ~| on the following @)

r Keyword Search

+ Filter

[Process [+][= [+] [animation | E G

[ status [+] [is not [+][compiete] | E G

I+ Parent

& Children

[_search | [_Ciear ]

The Filter section allows for the creation and activation of search filters. Each search filter operates on one attribute
on that sType. These searches use standard text search logic and supports TACTIC's expression language.

The Clear button clears out all the datain all the search filters: resets the drop down selection boxes and clears out
the input search criteria box.

Parent Search

create_schema

(@ alm] | (2

[?. @~ B :s ,83,J ‘ 3 items found

(W] Category  Title
- n video Muclear Explosmn
Car Chase
[(m]
video Scene 22

sType List
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Search Criteria

Search Clear [ Match an [=] on the following @)

r Keyword Search
b Custom

I Filter
v

Parent

|asset_categury El - | Code El |i5 E||vide0|

&+ Children
Search ] Clear ]

A search can be based on any property of a parent search type. For example, if asset_category is the parent type

then a search can be made based on the properties of the parent. For example, afilter can be created on the parent
(asset_category) where the codeis "video".

Children Search

Search Criteria

Search Clear [ Match an [=] on the following @)

Keyword Search
Filter

F
F
I+ Parent
v

Children
[ task [+] - [Friority [+] [is greater than EHB B
Search | Clear |

The Children search filter alows refining based on data in columns in the children. For example, a filter can be
created to find all tasks where the priority is greater than 3.

Matching and Compound Searches

Click the[+] icon beside a search parameter to add additional search definitions.

Search Criteria
Search Clear [ Match an [=] on the following @)
r Keyword Search
» Filter
[Projectcode [+ [ie [=][PrOJECT |
[ atribute = [+] [ [+ |
[ atrioute - [«] [is [« = @
I+ Parent
& Children
Search ] Clear

The drop down selection box at the top of the search box can be used to set up the search to be match open (matching
any of the definitions) or match specific (matching all of the definitions). The default match option is "Match all”.
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Search Criteria

Search ] Clear | Compound search El on the following &)

r Keyword Search

= Filter
|Prncess El |i5 E”Lighting G
and
Ul [Pocess  [v][s [v][composiing G
F‘[ Click to switch between 'and'/"or'. Shift-Click to switch between logical levels ]
¥ dTETTT
i Children
Search Clear ]

Compound Search gives the capability to set an AND or an OR option for filters. The default compound search
optionis"AND".

To switch the compound search option, select "Compound Search” from the drop down selection box at the top, add
anew search filter, click on the word "and" that appears between the search filtersto toggle it to "or".

Search Criteria

Search ] Clear | Compound search El on the following &)

r Keyword Search
» Filter

| Process El | is El |Lighting G
and
[¥] [Process [=][is [=][compositing G

Click to switch between 'and'/"or'. Shift-Click to switch between logical levels ]

2 ATETTT

& Children

Search Clear ]

Operators

Search Criteria

Search ] Clear | Compound search El on the following &)

r Keyword Search

» Filter
[Process _[] [T ] [composiing .
&+ Parent is not
. contains
¢ Children does not contain
iz empty
Search | | Clear | |isnotempty
starts with

e cnds wiith
in

not in

is distinct

is Finds an exact match. eg. Process "is' Compositing

isnot Findsall theresultsthat do not match exactly. eg. Process
"isnot" Compositing

contains Does a partial match. eg. Process "contains' ompost
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does not contain Finds all the results that do not match a partial match.

isempty Match the empty field.

startswith Match on the beginning part of the string. eg. Process
"starts with" Comp

endswith Match the ending part of the string. eg. Process "ends
with" ing

in Match any of the strings delimited by "|". eg Process"in"
Compositing|Lighting

not in Find all the resultsthat do not match the strings delimited
by "|".

isdistinct Skip duplicates. eg. Sequence "is distinct".

The"In" Operator

It is possible to search for itemsin alist using asimple text string with a"|" operator. For example, search for either
"TM_001" or "TM_002" or "TM_003":

Sequence code [in] "TM 001| TM 002| TM 003"

- R ‘ 8items found | Showing: « [1-8 «|w [ A e 1filteris ‘ az
.
Sequence Shot

Search Criteria

WL L LI |__Search __Clear | Match all [+]on the following &)

. Keyword Search
TWM_002 TWM_002_001
I Custom
+ Filter
TM_D02 TWM_002_002 | Sequence Code El | in E| |Tr.|_uu1TM_DDZTM_DUS
. Parent
TH_003 TH_003_001 . Children
|__Search |__Clear .]
TM_003 TW_003_002

The vertical bar (alogical "or") is a delimiter that specifies that the search should look for any item with the code
"TM_001" or "TM_002" or "TM_003".

To switch the compound search option, select "Compound Search” from the drop down selection box at the top, add
anew search filter, click on the word "and" that appears between the search filtersto toggle it to "or".

The" IsDistinct" Operator

This operator filters out items with the same column value. ie. Theresults will only contain itemsthat have a distinct
entry in that column.

Sequence code [is distinct]
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[@ @« = =2 -4;'] ‘ 18 items founc

L Shot
2001
o
TM_001 TWM_001_001
[
TM_002 TM_002_002
o At
i i 4
TM_003_005
[
TM_004 TM_004_002
o
TM_005 TM_005_001
[
Search Criteria

_search | [ Clear | Match i [+] onthe following )

. Keyword Search

I Custom
+ Filter

| sequence Code [+ | |is distinct EH B

. Parent
. Children

|Sear{:||]|c.lear]

note: there is no need to put any criteriain the box when using the operator is distinct

Saving Searches

When saving aview as either "Project View" or "My View", the search filters are also saved with the view. Once the
view issaved, the next time the view is opened, the search filterswill be applied. Thismakes saving aview essentialy
like generating a report with a predefined set of criteria.
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Compound Searching

For some searches, the search filters need to grouped and evaluated in a specific order, in order to achieve the desired
expression. Although not always necessary, this type of "compound" search is useful when complex filtering is
required. Generally, compound searches involve the ability to evaluate a search expression similar to the following
example:

[Aor B] and [C or D or E]

Here is an example of a compound search on tasks:

[project, is, "{$PRQIECT}"]
and
[assigned is, "{$LOG N}"]
and
[status, is "Approved"]

or
[status, is "Review']

This search can be phrased as: "Find al tasks from the current project, assigned to the current user with a status of
Approved or Review".

Note
$PROJECT and $LOGIN are used as variablesin the search that are dynamic based on the environment.

To do thistype of search in TACTIC, in the Search Box, set the "Match" option to Compound Sear ch:

Search Criteria

[_search | [_clear £ Match all i |onthe ing &

Match all |

|+ ouick Search Match any
I ‘Compound search

In this search mode, the choice of filters are al "and" or all "or". Groups of searches can be created by SHIFT-
clicking on a particular "and" or "or" between the search filters.

Search Criteria [X]

(_search | [_Clear | Compound s=arch [ ¥ | on the fellowing &

- Quick Search

. Custom

« Filter

Sequence Code : contains : |TM E

Code ! contains! 003 E

or
Code : contains : [ons E

i Parent

. Children

Example
To create the example above:

1. Load aview of tasks and set the search match setting to "Compound Search"
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2. Add thefollowing Filters
 project_code, is, "{ $SPROJECT}"
e assigned, is, "{SLOGIN}"
e dstatus, is, "Approved"

e status, is, "Review"

Search Criteria

M l Clear J | Compound search El on the following &)

Quick Search

Custom

« Filter

V) Fomices [w][c [F]roeen @ @

or

e [¥] s [ ][soon @

or

G [=[c []Pewores Q
@ e [Pl []Ree @a

i Parent

Children

(Csearen ] [Cciear ]

3. Now click the and/or to toggle al to "and"

4. next SHIFT-Click on the "and" after the first and second filters.

| ‘Compound search El on the following &)

[Posicore [=][s  [w]rokcn @ @
Assigned is [SLOGIN} Q G

Status i Approved G

@ e [Pl []Ree @a

i Parent

. Children

(Csearen ] [Cciear ]

5. Inthe new group, click the and/or to toggleto "or"

6. Run the search.
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Expression Searching

Expression values

The search criteriainput for search filters can be TACTIC expressions. To signify to TACTIC that a search criteria
is an expression, wrap the expression in curly braces {}. This signifies to the search engine to evaluate the value as
an expression before sending it to the search.

Having the search criteriabe a TACTIC expression allows for many uses of predefined variables in the expression
language.
For example, the following will search for all tasks for this week based on a Sunday to Sunday work week.

timestanp "is after" "{$PREV_SUNDAY}"
timestanp "is before" "{$NEXT_SUNDAY}"

Hereisthe TACTIC expression to find all of the checkins that have occurred this month:
timestanp "is after" "{$TH S_MONTH}"

Hereisthe TACTIC expression to find all the tasks for the current project:

proj ect _code "is" "{$PRQIECT}"

Note: the curly braces{} around these predefined variables are not needed in the expression mode described below.

Full Expression searches

Full expressions searches are an advanced way of searching for results. For each column, thereisan "**expression”
option. This option provides the ability to use the full power of the expression language within a search that are
beyond the capabilities of the search user interface.

The full expression executes an evaluation on this expression then relates the results to the main search. Careful
consideration must be take to refine an expressions so that is as efficient as possible.

For example, search for al of the assets that have model tasks:

@BOBJECT( st hpw/ t ask[' context', ' nodel '])

This search will first execute a search of all of the tasks that have model. Note that this does a search on al of the
modelling tasks. With alarge number of tasks, this operation can be heavy. Care must be taken to minimize the results
of the expression. One way to make the search more efficient is limit the search to just that of the current project:

@OBJECT( st hpw/ t ask[ ' proj ect _code' , $PRQJIECT] [ ' context', ' nodel '])
The expressions can be combined with other filtersin any combination so that very complex searches can be achieved.

For example, another more complex search isto find al items with a modelling task assigned to someone in the
"toronto" location (assuming there is a custom property on the login table), we can use:

@BOBJECT(st hpw/ | ogi n[' | ocation','toronto'].sthpw task[' project_code', $PROIECT]
['context', ' nmodel'])

This works because tasks (sthpw/task) and logins (sthpw/login) are connected through each other through the
"assigned" column in the task table and "login™ column in the login table.

There are 4 modes available to the expression search: "have", "do not have", "match”, "do not match". These four
searches can be applied to the Shot List page.
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. Results "have" "@SOBJECT (sthpwi/task)" will show all items that have tasks in them. This mode must return
itemsin the expression.

. Results"do not have" " @SOBJECT (sthpw/task['context’,'model])" will show all itemsthat do not have modelling
tasks. This mode must return items in the expression.

. Results "match" " @COUNT (sthpw/snapshot['context’,'model'T) > 3" will show all items that have more than 3
snapshots. This mode must return True or False in the expression.

. Results"do not match" "@COUNT (sthpw/snapshot['context’,'model']) == 0" will show all itemsthat do not match
the condition where model snapshot count is 0. In other words, it means thereis at least 1 or more model check-
in for the shot. This mode must return True or False in the expression.
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Tasks and Schedules

Creating Tasks

T a >
[‘} @~ H i q;'] 11 items found Showing: «)[1-11 [=]m of

= @

[ Preview Category AssetCod Title Description Keywords Checkin History Tasks Taskl|

video assetd01  MNuclear Stock footage of  explosion, fire, <,_‘ (] 4 1
Explosion anuclear nuclear, bomb o7
explosion Revie'

——

4 llems bund snowing: w4 [1-4 | b EH | EH
L] Worl Process Des Milestone Status Assigne: Supervis Prio | s no fied The | F
25 26 27 28 2
[ # design Delivery Mid Project | Review | beth bobby O Jul2g e
= ,-\ rough Delivery Mid Project Pending mark bobby 4
o & fina Delivery Mid Project | Ready beth bobby 5 JUlZ28 e

2 & delivery Delivery Mid Project -l bobby bobby 0

Insert/Edit Tasks

There is more than one way to create new tasks. The following describes explains each way.

Task Menu

Select the item to add tasks to. Then, go to the Gear menu for the view and select Tasks-> Add Tasks To Selected.

. R 1 itemsfound | Showing: «[1-11 [+]m
Edit ¥ | Description Keywords Checkin |
i » ;
F"_e Stock explosion, &
Clipboard * [footage ofa fire,
Wiew ¥ Inuclear nuclear,
Print » [explosion  bomb
Chart »
Stock car, chase, +
£, L, £ £ L =
Show Tasks
Notes »
Check-ins * Add Tasks to Selected
Pipelines * Add Tasks to Matched

Check mark the processes to add the task to and then hit Add Tasks.
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Add Tasks to Selected (=}

Total: 1 items to add tasks to @)

N

Pipeline: projectiasset

toggle all
design
rough
final
delivery

skip duplicated (g)

The skip duplicated option skips adding a task that has already been created for that process e.g. if only atask for
design has already been created.

Notice the new tasks added to the Task Pipeline column:

Task Pipeline
design rough final delivery
07/25 - 0729 08/01 - 08102 07/26 - 07130 08/04 - 08/04
(R~ ] (Watng [+ ] [Wating " [~| [Waiting " [~]
beth mark beth bobby
design rough final delivery
07M8 - 0723 08/01 - 0802 08M0 - 0813 08/04 - 0&/04
[Pending [~ ] | [Ap [~] | [aeei [~] | [aeei [~]
beth brad brad bobby
design rough final delivery
07/28 - 07/28 08/03 - 08/04 08/02 - 08/05 08/04 - 08/04
[REGEWN <] [Approves  [+] [ReVEWIIIN ] [Waiing -
brad beth beth bobby

Another way to create atask isto create atask by context. Thisis provided in the drop down selection menu.

Add Tasks to Selected (=}

Total: 1 items to add tasks to @)

Creste tasks by [Eamim_[5] ©

Ao 1 Pipelingd, context
all contexts in process

Pipeline: projectiasset

toggle all

design

rough
final

delivery

skip duplicated (g)

Createtask by: Process Displays al the processes to select from, to create atask for.
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Createtask by: Context Displays al the contextsto select from, to create atask for.
Createtask by: All Contextsin Process Creates al the contexts defined in the pipeline, but only displays the processes to select |

Task Edit Column

The Task edit column can be used to insert tasks one at atime for a particular item.

4lemstund  Showng [T

ilestone  Status

Delivery
[m] Mid
Project

7% rough Delivery .

(W] Mid
Project

Task Status Column

Once an item is created which has a pipeline, the widget will show a green insert button (+). This will load the task
creation GUI to create tasks for the item.

2 ASSETO0007 character 3 @ Mo tasks. Click to Add
(W] No tasks
u I test_char_ 001  character b bid concept
0111 - 01428 0111 - 01711
w ) E D review review
jimmmy brad

Task Properties

Add Single ltem =]

Created for

Process

Description

Milestone Project Start =
Assigned brad

Supenvisor cindy

Bid duration

Priority 4 - \ery Important ﬂ
Pipeline code projectistatus_default ||

Status ignment =

[_Add_J [ Cancel |

Each Task can have the following attributes.
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Process The currently selected process. Use the menu to select a different process to perform on the current parent &
Description A description to identify the task.

Milestone Assignment to a milestone item that represents a specific milestone in the project.

Status The status of the currently selected task pipeline.

Assigned The user assigned to complete the task.

Super visor The user assigned to supervise the task.

Priority The priority level of the task.

Bid start date Proposed date to start the assigned task. Drag the date in the calendar to set.

Bid end date Proposed date to complete the assigned task. Drag the date in the calendar to set

Bid Duration Proposed amount of hours to complete the assigned task.

43



TACTIC End User

Gantt Widget

Status Assigned Bid start date Bid end date =

P16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 01 02 03 04 05 06 O7 08 09 10 11 12 13 14 1¢
Approved  ted 2011-07-19 00:00:00 25/07A100:00  Jul 19 7o Jul 25
(R oo 2011-07-21 00:00:00 05/08/11 00:00 Jul21 S Auq 05
[ oo 2011-07-28 00:00:00 03/08/11 00:00 Jul 25 S Auq 03
Review | bobby  2011-08-0100:00:00 05/08/1100:00 Aug 01 IISEENIN Aug 05
Pending | mark  2011-08-06 00:00:00 10/08/1100:00 Aug 06 (10 & Aug 10
Ready admin  2011-08-10 00:00:00 23/08/11 00:00 Aug 10
Description

The Gantt Widget displays a horizontal bar graph representing the item's start date, end date and duration. The bar
graph can be clicked on and dragged to manipul ate schedules for projects and task schedules. The widget has 2 view
modes: weeks and months view.

Usage
View modes: Toggle the Gantt Widget between the 2 viewing modes by double clicking on the column header.
view mode: months

2011
Jun Jul Aug

Jui 09 EEEEE Jul 24

view mode: days

Jul
01 02 03 04 05 06 O7 08 09 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 21

Jui09 e Jul 24

Start/End Date: Modify the start and end dates by left clicking and dragging them.
Hover Pop-up: Hover the cursor over the horizontal barsto pop-up awindow that displaysthe dates of the schedule.
Shifting the bar: Click dragging the bar shifts the start and end dates bar while maintaining the duration.

Multi-selection Edit: First, check mark the items to be modified.

2011
] Description

23 24 25 26 27 28 29 30 31 01 02 03 04 05 06 OF 08
¥ Plan scope of project Jul 25 . Aug 03
¥ Meetings with client Jul 26 EE Aug 04
¥ Consultant onsite Jul 27 . Aug 05
[C] Design Planning Aug 01 SoEE Aug 05

Adjust multiple start dates: With multiple items selected, click drag on one of the start dates to adjust al the start
dates simultaneoudly.
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[ Description o

L imm s imimw e e e w o s e w o
@ rianscope et s e—_03
@ et v e o ee———0
—— L eeem——"05
[ Design Planning Aug 01 EEEE T Aug 05

Adjust multiple end dates: With multiple items selected, click drag on one of the end dates to adjust al the end
dates smultaneously.

Design Planning Aug 01 EEEE T Aug 05

Shift all the bars: With multiple items selected, click drag on one of the bars to shift al the start/end dates
simultaneously while maintaining the duration.

" Description =

e ExnBE BB Fo 20 BSO0 0 fet 02 Fo3 oe foS 06 Dar o8
< Plenscope e L e ————"
2 e i o L ee———"C
¢ Consutanonste L e———t
[ Design Planning Aug 01 EEEE T Aug 05

Shift the view: Click drag on an empty area of the Gantt Widget to the mouse left or right. The bars and the units
will shift while maintaining their values.

[] Description =

e — R

[ Plan scope of project [ | Jul 25 T
[ Meetings with client [ ] Jul 26
[ Consultant onsite [ | Jul 27
[] Design Planning | Aug 01

Scale the view: Hold down the shift key. Then, click and hold on an empty area of the Gantt Widget and drag the
cursor to the left or the right. The bars and the units will scale while maintaining their values.

[ Description =
mmmmmmmmﬁamammmm
(] Plan scope of project 0 Jul25 EETEEE Aug 03

[ Meetings with client [ Julzs O Aug 04

[J Consultant onsite | Jul 27 R EEE Aug 05

[ Design Planning [ | Aug 01 FTSEETTN Aug 05
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Notes and Communication

Notes Widget

Introduction
The Notes Widget provides the ability to add a note directly to an item in the view. The notes are tracked in

chronological order and and are also grouped by processif entered against tasks. Other conveniences provided in this
widget is the ability attach files and to CC/BCC extra email addresses when you submit the note.

Adding a Note

If the Notes widget is not in the view, it can be added through the Column Manager.

To add a note, go to the Notes column and click on the plus sign in the top right corner.

[’27 @~ = =2 .UJ‘,] 10itemsfound ~ Showing: «[1-10 [+] 2L

_ Preview AssetCod Title Notes

asset001  Muclear » design (2}
Explosion » Aug 10 - 22:35 - [cindy] - Please work on the particle effects.

design
Please work on the particle effects.

cindy Aftachments: 0
Cindy Client
dan@southpawtech.com

# Aug 08 - 19:50 - [beth] - There was some trouble with this please
have al ...

design
\,1-' There was some trouble with this
please have a look.
beth
Beth Content Creator Attachments: 0
dani@southpawtech.com

» final (5) G

For Process: | final [+

Mote:
I've fixed t. Please validate.

Attach File(s)

» Mail Options
Mail will be sent to:

Extra list of emails to send mail to (separated by commas):
Cc:
Bce:

The "For process:" drop down allows you to select the pipeline process to add the note to. If there is no pipeline for
the item, then a default process will be used for the note.

The Submit button will save the note to the item.
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Additional Note Options:

To attach afile, click on the Attach File(s) button. The file browser will open to prompt to select afile.

Additional fieldsto input Cc or Bcc email addresses can be found at the bottom, under Mail Options.

Note

If Notification Triggers have been set up in the project, emails will automatially be sent to the appropriate
users when notes are added. Adding a CC email address to a note simply sends the note to the email
addresses regardless of Noification Triggers.

Multiple Notes

When multiple notes are saved to an item, the interface will look like the following (notice that the notes for the item
are conveniently categorized by process):

Collapsed
[ 2 ©@~H :is .UJ‘,] 10itemsfound ~ Showing: «[1-10 [+] 2L
~ Preview Asset Cod: Title Notes

asset001  Muclear » design (2}
Explosion b Aug 10 - 22:35 - [cindy] - Please work on the particle effects.

b Aug 08 - 19:50 - [beth] - There was some trouble with this please
have al ...

» final (5)
- rJan 13- 20:26 - [admin] - test private note
b Jan 13- 20:25 - [admin] - Almost there.
b Aug 10 -22:35 - [cindy] - | like it
¥ Aug 10 -01:35 - [beth] - Looks good
b Aug 08 -19:51 - [beth] - | have some issues with this checkin

» rough (1)

b Aug 08 -17:51 - [admin] - Rough looks good.

Expanded
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w design (2) .
w Aug 10-22:35 - [cindy] - Please work on the particle effects.

design
Please work on the particle effects.

Attachments: 0

cindy
Cindy Client
dan@southpawtech.com

w Aug 08 - 19:50 - [beth] - There was some trouble with this please
haveal .

design
There was some trouble with this

please have a look.

beth

Beth Content Creator Attachments: 0
dan@southpawtech.com

- final (5) @

w Jan 13- 20:26 - [admin] - test private note

=

test private note

admin
Admin Attachments: 0
dan@southpawtech.com

w Jan 13- 20:25 - [admin] - Almost there.

final
Almost there.
admin
Admin Attachments: 0

49



TACTIC End User

Note Sheet

Introduction

The Note Sheet widget provides a convenient layout for typing in notes for different processes in one concise user
interface. The Note Sheet isalso built to provide rapid interface for entering notes. For exampl e, the Note Sheet helps
in daily review sessions where the ability to enter notesin rapid succession is necessary.

Asset Tracking =
Keywords: m Asset s [v][—select— [+]
Category:
[ 2 ©@~H :is .UJ‘,] 13itemsfound =~ Showing: «[1-13  [+] e
| Preview Asset Cod Title Notes sheet Notes
assetd01  MNuclear Explosion 7 I design (2)
(™ I final (3}
= I rough (1)
a2, a ‘_|' [7] make notes private
Design Rough Final Delivery
Ilistou save Ilistou save Ilistou save [] private
[] private [] private [ private  Last note
Last note (08/10 22:35) Last note (0808 17:51) Last note (08/10 22:35) — No Notes —
Please work on the paricle effects.  Rough looks good. | like it

Description

Notes can be entered for any item. When the Note Sheet widget isadded asacolumn, by default, the pipeline processes
are used as the processes for note entry. The processes for the example item shown in the screen shot above include
design, final, rough and delivery. The Notes Sheet widget allows entering of many notes in different processes and
different parents at the same time. They can be saved either individually or altogether. The private check box option
make a note private.

Usage

When the Note Sheet is expanded, it may require that the processes be selected to display. At the top of the widget
is abutton which allows you to load a process selection pop-up which exposes the desired processes.

2, ||[E ||| [[Imake notes private

Deoin Processes 41 Final
Refresh
design
[ rough [ private save history
Last note (08 final Last note (0810 22:35)
Please work)| (] delivery llike it

After you are finished with note entry, you will two buttons appearing on the top right corner. Clicking on "save" will
saveall of the notes. If you have the Note Sheet Widget opened for vehicle001, vehicle002, and vehicle003, clicking
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on the standard save all will save all new notes in the view. To save one note at atime, there is aso an individua
"save" button for each process.

Clicking on the history button pops up a window which displays all the note entries under this particular context.
Private Notes

The private check box turns a note accessto private if checked. The private option isabuilt in access rule which can
deny agroup of users from being able to see notes flagged as 'private’.

Note

Note - When using the Note Sheet on items such as Tasks, Notes and Snapshots, the default assumption
will be to add a note to the parent item for the particular process. For example, if adding a note to the
"design"” task, anote will be added with the same process.
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File Management

General Check-in

Introduction

The General Check-in widget providesinterfaceto do many of the most common kinds of check-insusedin TACTIC.
It is a highly configurable widget that allows a project to have customized check-ins for any part of the content
creation process.

Check-insare the ability to in TACTIC to take files that have been created and submitting them to TACTIC's central
repository to be organized, stored and versioned. TACTIC hasacomprehensive ability to track filesand their histories
with the added benefit of enforcing naming conventions.

The general check-in widget can handle:

e Single Files- Animage, video, document, etc

¢ Sequences - Commonly image sequences

« Directories- Full directoriesincluding files and sub folders

e Complex packages - Handling of a project source including project and source medial files.

Interface

The interface below shows a standard example of the General Check-in widget.

Check-in Widget =]
r 1 Check-in [asset001]
Process: | design El P 5= - 5
= b B s
Ciisthpwisandbox/projectvidec/asset00 Select All -
assetd01_design_asset001_final_v005 bd_v001 bd 0B
- assetl inal_v005.bd fvr) 0B
asset001_final_v006.bd 0B
asset001_icon_v001.mpd 1.8 MB
Check-in assetd01_icon_v001_icon jpg 46 KB
media

I b ¢4) Check-in History I
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Tool bar

The tool bar contains a number of use functions.

2 B E=> 8, & 4,

Refresh Refreshes the whole widget and will aso rescan the sandbox for any changes.
Browseto working folder | Allows the user to browse to a new location for the working area.
Set to My Documents Sets the working area to the My Documents directory

Set to Desktop Sets the working area to the Desktop directory.

Browse Allows the user to select file(s) or directories to check in directly.

Set Sandbox Set the sandbox automatically based on the naming conventions. This makes setting up
aworkspace very easy and organized.

Check-out tools Toolsto assist in Checking out files. Described in the section " Check-out” below

Explore Sandbox Opens up the folder directly on the users computer. This alows for the quick copying

and pasting files into your sandbox workspace.

Process Select

Check-ins for an item are always classified by a processes. TACTIC organizes all of the check-ins with various
processes that are defined for that item. The current process can be sel ected by the process selection drop-down. This
often times corresponds to a task assigned to that user for that process.

s Check-in [asset004]

Process: |desion [+]

This will only show up if a pipeline has been defined for the item. If no pipeline has been defined, then a default
process called "publish” is used.

Often this selection will be locked because it is associated with an assigned task. A user will often work from atask
also associated within a particular process and then choose to check in files based on content created from this task.

Sandbox Area

Ciisthpwisandbox/projectvidec/asset00 Select All -
assetd01_design_asset001_final_v005 bd_v001 bd 0B

- assetl inal_v005.bd fvr) 0B
asset001_final_v006.bd 0B
asset001_icon_v001.mpd 1.8 MB
asset001_icon_v001_icon.jpg 4.6 KB

media

On first load of a new task (process) the check-in widget will assist the user in setting up awork area.

The user experience protocol will determine how the user leverages the features in the sandbox. The recommended
approachisto allow TACTIC to create a sandbox location for the current process. This method is beneficial because
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it helps the user organize work-up files before they are even checked into the server. This approach is recommended
because it creates an easy accessible and well organized file system on the users computer. It is however, possible to
check in files from ancther location on the file server using the browse buttons in the tool bar.

> = Comae)

If If If

' Use the above buttons to browse for files or folders to be checked in.

OR workin the Sandbox Folder for process [design]
"C:lsthpwisandbowproject/3diassetd03”

The sandbox folder is a work folder allocated for this process. It
does not yet exist. If you wish to work in the sandbox folder, press

the "Create” button.

During the content creation process, userswill createfilesand savethem under this sandbox folder. All filesassociated
with thisitem should be stored here. It should be noted that this sandbox work areais not strictly enforced and it is
easily possible to navigate to other folders to check in filesto a given asset. However, it is considered good practice
to have user's create filesin awell defined location in order to more easily manage overall disk space usage.

Any files created in the sandbox area will be display in this section. If any new files have been created and are not
reflected in the interface, then a simple refresh should make these new files appear.

Files that have been checked-in will show a small indicator in the icon to the right and will be colored in blue. The
small indicator will either be a green check mark, which indicates that the file in the sandbox is identical to the
checked infile. If the indicator is ared exclamation mark, this means that the file has been changed and is different
from the checked in file.

To select al filesin the sandbox area check off the " Select/Deselect All" check-box on the top right hand side.

SelectDeselect All: (V] «

To quickly select al changed files, click on the arrow to open up extra menus and select " Select Changed Files'.

SelectDeselect All: N
Select Changed Files
T1KB

All filesthat have been changed since the last check-in will be selected. TACTIC will remember the last subcontext
checked in for thisfile so. This alows changed files to be easily rechecked in when changes have been made.

Clicking on the right mouse button of any file will open up a context menu.

asset001_design_asset001_final_v005.td_v001 tet 0B
o asseti01_final_| 0B
asset001_final | Open File 0B
asset001_icon_| Copy File to Sandbox 1.8 MB
asset001_icon_| _ 4.6 KB
media Delete File
Properties
Use as Preview Image
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The following actions are available:

Open File Open the file using the application as set up by the client operating system.
Delete File Permanently delete the file from the sandbox area (and on the computer).
Properties Open up apop-up showing the propertiesof thisfile, including all past check ininformation.
An example is shown below:
File Properties =]
Local Path: C: P dbox/project/2d/; t004/design/details.xml
md3: b561c995ec486105f735ab5185ebb998
snapshot_code: 1623PROJECT
Preview Locked Files Context Ver# Rev# Login Timestamp Description Current Latest
- design/details.xml v00002 0 admin 1239 More data Y 4 Y 4
added
. design/details.xml v00001 0 admin 12:26 Initial

checkin

Check-In

When any files are ready to be checked in, they can be selected. The row will highlight for all selected files, and either
aselection list, or atext box will appear on the right side. Since many files can be checked into the same processin
an asset, this provides a sub-category to organize checked in assets (thisis known as the subcontext of the context of
acheck-in). By default, this should read (auto) which meansthat it will be automatically filled in.

When al of the files that need to be checked in have been selected, the check in widget will be enabled.

It's good practice to add a note in the Description field while performing a check-in. Thisisimportant so al project
users understand why a particular check-in was made, and where it's located.

When the "Check-in" button is pressed, all of the selected fileswill be transferred to TACTIC'srepository. There are
anumber of ways that the files can be configured to transfer files. When TACTIC checksin afile, it will move them
to the correct folder, version and rename them to the correct file name as specified for the naming conventions.

Check-in Subcontext types

When checking in, adrop-down is available beside each file or directory. This functionality allows control over how
each check-in will be handled. Thistype of control is called subcontext. This can be looked at as a sub process for
the sub-directories included in a check-in.

Auto

The "Auto" mode is used if it's desired to keep file names the same as they are before the check in . This work-flow
is beneficial if one wishes to keep file names, or work in a situation such at subversion where files are constantly
overwritten and versions are handled automatically in the background.

Sandbox SANDBOX/project/assets/asset001/design/origina_file.jpg

Check-in SERV ER/project/assets/asset001/design/origina _file.jpg

SERVER/project/assets/asset001/design/.versiong/original _file_design_v001.jpg
Check-out SANDBOX/projcet/assets/asset001/design/original _file.,jpg

Main
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If only one file/directory/sequence is going to be checked-in, it will also be re-named correctly by the naming
conventions. Thisis often the case when files are delivered to another department or the client.

Sandbox SANDBOX/proj cet/assets/asset001/design/origina_file.jpg

Check-in SERV ER/project/assets/asset001/design/asset001_design v001.jpg
Check-out SANDBOX/projcet/assets/asset001/design/asset001_design v001.jpg
Text

If more than one file/directory will be checked in and strict control is required for each item, the subcontext will
be different each time a check-in happens. This often applies when different variations of a check-in are required.
For example a blue and ared version of afile might be needed for a particular check-in, so the user would type this
in for each file:

Sandbox SANDBOX/projcet/assets/asset001/design/original_file_red.jpg

SANDBOX/projcet/assets/asset001/design/origina_file_blue.jpg
Check-in SERV ER/project/assets/asset001/design/asset001_design red_vO001.jpg

SERV ER/project/assets/asset001/design/asset001_design blue v001.jpg
Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_red v0O01.jpg

SANDBOX/proj cet/assets/asset001/design/asset001_design_blue v001.jpg

List

If more than one file/directory will be checked in and strict control isrequired for each item, the subcontexts are the
same every time a check-in occurs. This often applies when there are multiple sub-directories that need to be worked
on for atask. For example, a preview, project file and a directory of media files would be organized by selecting
preview, project or mediain the drop-down.

Sandbox SANDBOX/projcet/assets/asset001/design/original_file_preview.jpg
SANDBOX/projcet/assets/asset001/design/original_file.psd
SANDBOX/proj cet/assets/asset001/design/medi a/background.jpg

SANDBOX/proj cet/assets/asset001/design/media/foreground.jpg
Check-in SERV ER/project/assets/asset001/design/asset001_design preview_v00L1.jpg

SERV ER/project/assetsy/asset001/design/asset001_design_project v001.jpg

SERVER/project/assets/asset001/design/asset001_design_media v001
Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_preview_v00L.jpg

SANDBOX/projcet/assets/asset001/design/asset001_design_project v0O1.jpg

SANDBOX/projcet/assets/asset001/design/asset001_design_media_v001

Note

Often these options are predetermined by the pipeline configuration set up by the TACTIC administrator.
Other combinations file/directory naming and file version control can aso be configured through naming
conventions.
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Check-out

When working on a particular task that is part of a pipeline, files may need to be checked out or "downloaded" to be
worked on or revised. TACTIC assistswith this process and alows easy accessto retrieving theright files/directories
from the TACTIC server.

Check-out options menu

Check-out w/ Source Name

s or folder] Check-out w/ Repository Name 8
Check-out w/ Versionless Name o
T

A specific version can be checked out through the Check-out button in the History area. There are also more advanced
options available in the Check-out options menu.

Check-out w/ Source|Check out the latest version of different contexts based on the original file name that was
Name checked in regardless of naming conventions.

Check-out w/|Check out the latest version of different contexts using the repository names as seen in
Repository Name the TACTIC repo.

Check-out w/| Verisonless check-ins only - Check out the latest versionless of different contexts using
Versionless Name the the versionless convention as seen in the TACTIC repo.

History

This area shows the check-in history. By default, this information is collapsed but can be accessed by clicking on
Check-in history.

# ¢1) Check-in History
%, Context:|design  [v| Versions:|last10 [

[ Preview Lot Files Che Context Ver# Rev Login Times Description Cur Note:
o design w00003 0 admin 1516 Refined the outer edges Y 4

m

o design w00002 0 admin 1512 Changedthe color from blue to green

o+ design w00001 O admin 14:24 Initial checkin - rough work

# ¢1) Check-in History

2, Context:|design  [v| Versions:|last10 [
[ Preview Locked Files Checkout Context Verd# Rev# Lc

O

design vl 0 ad

b
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Time tracking

Tracking User Work Hours

The TACTIC system has built-in work hour tracking, which can be tracked per task or work hours can be entered
manually.

By default, hours can only be submitted to a task by the user that task is assigned to. For example, if an asset has
a pipeline process called "texturing” and this process is assigned to the user Albert, then only Albert can log work
hoursfor this task.

Userslog work hoursin atask view with the "Work Hours" column.

. L o Jan Sun Mon Tue Wed Thu Fri Sat
Preview Created f Process Description Status Priority \Work on Task “ o8 09 10 M 42 12 14 '
asset001 design Review 0 P [ zo]l=e] I I 50

asset001 final 5 P B E

assetd02 design  Design Taskfor asset002 Pending 5 R | | | |5_u |2.U | | | 8.0

_ asset003 rough Approved 4 [ Ilze][se][1e][ ][ =0

Hours can be logged and edited per day, per task.

To view the logged hours, go to the Work Hoursview. (This view shows the hours for the user currently logged in.)

- Parent  Description Day Login Straight time
2012-01-09
= po:00:00 =
= asset00 Jan 09,12 beth 2.00
= asset00 Jan 09,12 beth 5.00
2012-01-10
= po:00:00 20

= asset00 Jan 10,12 beth 3.00

In the Work Hours view, you will see an item per time entry with totals per day and per week based on hours logged
on all assets.

To manually track work hours for other events (for example, daily meetings), click the insert button and fill in the
options in the pop-up window:
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Add Single ltem (=X}

[~ Selecta User [
o] I
e e —

bescrpton ||
e

[_Add_J [ Cancel |

Options

Login Thelogin (user) who the hours are for.

Day The day the hours are for.

Category The category of work the hours represent.
Description A description of what the time was spent on.
Straight Time The amount of hours for the entry.
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Importing and Exporting

Importing CSV Data

PoEH L N (= I =" B == LR
T A >
[ 2 O« HFH i q;_] 1 itemsfound  Showing | & [Adal |z| 1 |:
[ AssetCode Title Description
- Blig 12 ElaxzE =]
! assetddl Muclear Explosion Stock footage of a nucl ry B
= assetd002  CarChase Stock footage of a over 1 |id code title
' chase 2 1asset001 Muclear Explosion
¥ asset003  Carwy|mport CSV 3 | 2assetd02 Car Chase
4 3/asset003 Car Warehouse
» 3ssetd04 Sport Select search-type: 5 | 4assetd04 Sport Car Warehouse
project/asset (Asset) 6 5 asset005 Robot Bar
+ assetdD5  Robot 7
1 assetl0f Board Required Columns: n/a -1
O assetdd? Rockel File uploaded: project assst project pl 49"

Data can be imported into TACTIC and associated with the appropriate columns. Since TACTIC is based on atable
system, data can be exported asa CSV file for easy manipulation in a spreadsheet program.

: Note
1
For more information on exporting existing CSV data, go to the section, "Exporting CSV Data."
Toimport aCSV file

1. Goto Gear Menu -> File-> Import CSV ...

H 23 @ 1 itemsfound | Showing: «)[1-11  [+]
Category Edit » | Description Keywords  Chec
video : Export Al ...
Clipboard L4 Export Selected ...
View L4 Export Matched ...
Print L4 Export Displayed ...
_ Chart 3
video
Import CSV ...
Tasks *» Tovernead map
Notes ® | carchase.
Check-ins »
3d Pipelines » | 3D Car car, g
assetina warehouse,
warehouse dark,

. Select an sType or copy and paste the data from a spreadsheet. Once an sType is selected, the required columns
will be displayed to the right of the drop down. Although these aren't the only columns that can be imported for
this sType, they represent the minimum requirements for a successful import.
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Import C5V =]

Select sType to import data into: { projectiasset (Asset) iv|

Upload a csv file:

Copy and Paste from a Spreadsheet:

(_Upload ]

3. Browse and upload the CSV file. The CSV fileis the raw format required by TACTIC. Below is an example of
the contents of aCSV file:

“id","title","description"

, "Nucl ear Expl osion","Stock footage of a nucl ear expl osi on"
,"Car Chase","Stock footage of a overhead car chase."

, "Car Warehouse", "3D Car asset in a warehouse setting"
,"Sport Car Warehouse","3D Car sport car"

, "Robot Bar","Robots drinking in a bar"

O WNPRE

Below is an example of aCSV file being manipulated in a spreadsheet application.

c3 =] &= = |
Al B e ——

| 1 Jid ftitle description
| 2 | 1MNuclear Explosion Stock footage of a nuclear explosion
| 3 | 2CarChase Stock footage of a overhead car chase.
| 4 | 3Car Warehouse 3D Car asset in a warehouse setting
| 5 | 45Sport Car Warehouse 3D Car sport car asset in a internal warehouse setting
| 6 | 5Robot Bar Robots drinking in a bar

7

4. Click theUpload button. The TACTIC systemwill introspect the CSV fileand fill intherest of theimport interface.
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Import CSV

=]

Select sType to import data into: { projectiasset (Asset) iv|

# Parsing Options

Use Title Row: 7]
Sample Data Row: | 1[+| @
Encoder: | ASCI (defaul) [ ]

Identifying Column: | - Select -

File uploaded: project_asset_project_project_asset listcsy  [_Change |

The following is taken from first line in the uploaded csv file. Select the appropriate column to match.

o Usethe sample row to match which columns the data will be imported into TACTIC

C5V Column Value TACTIC Column Create New Column
0|1 id [=] | '|id
Muclear Explosion title [ | ite
Stock footage of a nuclear explosion | description E| description
Preview Data
(_Refresh | (_Import |
The following table will be imported into Asset (Showing Max: 100)
id title description
1 Muclear Explosion Stock footage of a nuclear explosion
2 Car Chase Stock footage of a overhead car chase.
3 CarWarehouse 3D Car assetin a warehouse setting
4 Sport Car Warehouse 3D Car sport car assetin a internal warehouse setting
5 Robot Bar Robots drinking in a bar

5. Parsing Options

# Parsing Options

Use Title Row: 7]
Sample Data Row: | 1[+]| @
Encoder: | ASCI (defaul) [ ]

Identifying Column:

UseTitle Row

When checked, this import will read the first row in the file to determine which item
columns are being imported.

Sample Data Row

Specify arow in thefile to use as a sample for the dataimport.

Encoder

Select the encoding format for the data: ASCII (default), UTF-8, Excel 1SO 8859-1
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I dentifying Column Select the column which unique identifies the corresponding row in the table to update
the data with.

6. Import

The bottom of the page shows a preview of theimport results. Hitting the | mport button will start the CSV import.

63



TACTIC End User

Exporting CSV Data

[ % @~ H il q,i‘.] 12items found = Showing: «)[1-12  |¥] oy s E
[ Preview Title Keywords Description Category Explorer History Tasks Pipeline code
Muclear explosion, fire, Stock footage of a video (] [ projectiasset
=) Explosion  nuclear, bomb nuclear explosion
- ﬁ CarChase car, chase, fast, Stockfootage ofa  video b | b projectiasset
: = race, map overhead car chase.
Car car, warehouse, 3D Carassetina 3d (] [ projectiasset
™ Warehouse dark, headlights, warehouse setting
exterior, engine
E project_asset_project_project_asset _list.csv - OpenOffice.org Calc
v
File Edit View Insert Format Tools Data Window Help
P - = = = = - & =
Ijglgl.J Arial |Z|10 EB]LJ =E = = E B % 3% T % es
Al =] & = = |
o B | [s | D |
id Jpreview title keywords description
= 2 1 MNuclear Explosion explosion, fire, nuclear, bomb Stock footage of a nu
s IE 2 Car Chase car, chase, fast, race, map Stock footage of a ove
4 3 Car Warehouse car, warehouse, dark, headlights, exterior, engine 3D Car asset in a war
|| 4 Sport Car Warehouse car, warehouse, interior, dark, headlights, engine 3D Car sport car asse
6
' Sheetl / 4 T
||| Sheetl/1 Default STD |*
LI

TACTIC uses adatabase and thus naturally exports to table-based outputs. TACTIC includes asimple user interface
to export any table-based view out to aCSV file (Comma Separated V aluesfile). Data can al so be edited and imported
to update or create new itemsin TACTIC.

Exporting Data

To export data from a TACTIC view to a CSV file, first check mark the rows to export. Then, go to the gear menu
and under File select one of the following options:

Edit »

Export Al ...
Clipboard L4 Export Selected ..
View » Export Matched ...
Print » Export Displayed ...
Chart »

Import CSV ...
Tasks »
Notes »
Check-ins »
Pipelines »

Other export options include

« Export All - All itemsin the database

e Export Selected - Only the selected itemsin the view.
* Export Matched - All items found by the search

« Export Displayed - All itemsin the current view.
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Next, select the columns to export from the selection list and click the Export Selected button.

Export Selected items from "projectiasset” list in [Assets] view to Csv [ Ed

Total: 4 items to export E

Select Columns To Export

Preview (preview)

Title (title)

Keywords (keywords)
Description (description)
Category (asset_category_code)
Explorer (explorer)

History (history)

Tasks (task_edit)

Pipeline code (pipeline_code)

¥
I
I
I
I
I
]
]
]
]

Include I (&)

i Note

Only columns saved to the current view will be available foe export. It may be ideal to save a view
particularly for exporting which includes all desired columns.

Depending on your web browser settings, the web browser will prompt to open or save thefile.

I Opening project_asset_proje

You have chosen to open

% project_asset_project_project_asset_list.csv
which is a: csv File (692 bytes)
from: http://10.0.0.27

What should Firefox do with this file?

OpenOffice.org Calc (default)

() Save File

[7] Do this automatically for files like this from now on.

Below is an example of the contents of the resulting CSV file:

"id","preview', "title", "keywords", "description", "asset_cat egory_code"

"1","","Nucl ear Expl osion", "explosion, fire, nuclear, bonb","Stock footage of a nuclear

expl osi on", "vi deo"

"2","","Car Chase","car, chase, fast, race, map","Stock footage of a overhead car
chase. ", "vi deo"

"3","","Car Warehouse", "car, warehouse, dark, headlights, exterior, engine","3D Car asset in a
war ehouse setting","3d"

"4" """ "Sport Car \Warehouse","car, warehouse, interior, dark, headlights, engine","3D Car sport

car","3d"

When the CSV file is open in a CSV-compatible spreadsheet application, you will be able to easily manipulate and
add data:
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Al B | [s | D | E | F
| 1 |id preview fitle keywords description asset_category_code
2 |1 MNuclear Explosion explosion, fire, nuclear, bomb Stock footage of a nuclear explosion video
3| 2 Car Chase car, chase, fast, race, map Stock footage of a overhead car chase. video
4 | 3 Car Warehouse car, warehouse, dark, headlights, exterior, engine 3D Car asset in a warehouse setting 3d
| 5 | 4 Sport Car Warehouse car, warehouse, interior, dark, headlights, engine 3D Car sport car asset in a internal warehouse setting | 3d
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Clipboard

Using the Clipboard

["—;"7 @~ H i q,,'a_] 11 items found | Showing: «)[1-11  [=]
Preview Categony| Edit » Description

File 2 ——— FRR——

Clipboard Copy Selected

View * Paste Clipboard

Print »

Chart * Append Selected

PREnd S& le of:

v Tasks Show Clipboard Contents

Notes
Check-ins

»
»
»
»

Pipelines farehouse 3D Car assetin :

Introduction

The Clipboard menu feature provides an easy method for transferring items (row data) from one view to another.
Items can al so be copied between different projects. Thisfeature can be used similarly to the copy and paste function
that we are familiar with in most applications.

The Clipboard Menu Options

The features for the Clipboard can be found on the tool shelf under the Gear menu -> Clipboard.
Theindividual options of the Clipboard menu are described in detail below.

Copy Selected

This menu option copies the items to the Clipboard that you have checked marked in the view. Either one row or
multiple items can be copied. Once the items have been copied to the Clipboard in memory, the destination view has
been navigated to, to allow pasting the items.

Note

The Clipboard has been built with the ahility to copy and paste items from one project to another.

Add Selected

This menu option copies the items that have been check marked and adds them to the items that are already have on
the Clipboard without wiping out what is on the Clipboard. This menu option is useful especially when navigating
through different views to gather row data.

Paste Clipboard
This menu option pastes the items that have been stored in the Clipboard into the view.
Note

Regarding copying and pasting to another project and the History column: After pasting the contents of
the Clipboard to the view, the latest History of the item's check-inswill refer to the item under the original
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path where the files live. The paths will point to the item in the new project as soon as the first check-in
transaction is completed for thisitem under the new project.

Show Clipboard Contents

This menu option opens up a pop up and displays the items that are currently stored in your Clipboard.

- T L%} o . .
[J} @~ HF i q;'J 11 itemsfound | Showing: «[1-11  [w]m [

[ Preview Categoq Edit » Description Keywords Checkil
B » .
video File — L 4
Clipboard * Copy Selected
o View L4 Paste Clipboard
= — Print »
. Chart L Append Selected
video £e2 -
I Tasks > v Clipboard Contents
Notes »
Check-ins »
3d Pipelines » 3D Car car, ¥
e assetina  warehouse,

& warehouse dark,
sefting headlights

Clipboard

- T L%} o . .
[‘?ﬂ &~ H :3 4,3'] Zitemsfound | Showing: «w[1-2  [=]m [

[ Project Login Search type Search | Timestamp Cate
(] admin project/asset?project=project 2 Feb 18, 2012-22:25 selet
(] admin project/asset?project=project 3 Feb 18, 2012-22:25 selet
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Transactions

Undo Your Actions

Similar to most software applications, TACTIC provides a convenient way to undo an action. Almost every action
in TACTIC isundo able. Transactions can include changes made to the database and to the file system (for example:
check-ins). One major benefit with TACTIC transactions is that they are not scoped to just your current session. If
you close down Tactic and log in aweek later, you can still undo your last transaction.

The Undo action can befound by clicking on thetop gear menu and choosing: Edit ->Undo L ast Server Transaction

Undo Last Server Transaction
Redo Last Server Transaction
Show Server Transaction Log

To see alist of the transactions which can be undone, click Show Server Transaction L og. (Thislog contains only
those actions completed by the user who is currently logged in.)

Transaction Log =]

Hefrezh

Show Undo Log From: RS0

\Legin_ 1 Hour Ago Timestamp Description Namespace Type Details
13334 admin I";:;‘Agn Jan 13,2012-20:26  Added 1 ltems for [sthpwinote]  project redo

1 Week Ago
1 Month Ago

13333  admin Jan 13, 2012-20:25  Added 1 ltems for [sthpwinote]  project redo 7

Transaction

=?xml version="1.0" encoding="UTF-8"7=

=transaction=

=l—new transaction —=

=s0bject search_type="sthpwinote” search_id="682" action="inser™
=column name="access" to=""/>

=column name="process” to="final"/=

=column name="search_id" to="1">

=column name="note” to="Almost there.”/>

=column name="context” to="final"/=

=column name="search_type” to="project’asset?project=project™=
=column name="login” to="admin">

=column name="project_code” to="project’/=

=/zobject=

=fransaction=

13332  admin Jan 13, 2012-20:08 delete_sobject project undao b
13331 admin Jan 13,2012 -20:07  retire_sobject project undo |
13330 admin Jan 13, 2012 -20:07  retire_sobject project undao b

Notice the drop down selection menu provides away to filter the transaction list by time.

Show Unde Log From:

Login 1 Hour Ago |

: Today
13334 admin 1 Day Ago

1 Month Ago

To reverse the transactions directly from thislog, click Undo to undo the most recent transaction in the log. Continue
back through the log, undoing one transaction at atime until the transaction to be undone is reached.

When atransaction is undone, it is relabeled with the type "redo" in the "Type" column. The original action can be
performed by clicking on the Redo button.
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T
tasks, 40, 44
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U
undo, 69

\Y,
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W
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notes sheet, 50
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